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conditioner.

Activity Mania
1. It’s My Computer

(a) MACHINE, (b) COMPUTER, (c) NATURAL,
A. 1. (a), 2. (c), 3. (a) (d) FAST, (e) PICTURE

B. 1. (T), 2. (F), 3. (F), 4. (T)
2. Parts of A Computer

Activity Mania
A. 1. (b), 2. (a), 3. (c), 4. (b)

 Mouse,              Keyboard,       CPU,          Monitor
B. 1. (T), 2. (T), 3. (F), 4. (F)

2. Uses of Computers C. 1. A computer mouse looks like a real mouse. It has 
two or three buttons.A. 1. (b), 2. (a), 3. Schools, Banks, Hospitals, Airports

2. Keyboard is used for typing.B. 1. (T), 2. (F), 3. (F), 4. (T)

3. CPU stands for Central Processing Unit.Activity Mania

4. Monitor, Keyboard, CPU, MouseHospital              ,   Bank              ,  School

Activity Mania

3. Hardware and Software Do yourself.

A. 1. (a), 2. (b), 3. (c) 3. Uses of Computer
B. 1. (T), 2. (F), 3. (F), 4. (T), 5. (T)

A. 1. (b), 2. (c), 3. (a), 4. (b)
Activity Mania

B. 1. (T), 2. (F), 3. (F), 4. (T)
Hardware—Mouse, Keyboard, Car

C. 1. In hospitals, computer help doctors to find out 
Software—Songs, Driving Rules, Windows diseases and in operations.

2. In schools, computers are used to educate the 4. Keyboard and Mouse
children.

A. 1. (b), 2. (a), 3. (c), 4. (c)
3. Bank, School, Railway Station, Shop

B. 1. (T), 2. (F), 3. (T), 4. (F)
Activity Mania

Activity Mania
A. Do yourself.

Do yourself.
B. BANK, SCHOOL, COMPUTER, HOSPITAL, HOMES

5. Windows and Internet
4. Know Your Keyboard

A. 1. (a), 2. (c), 3. (c), 4. (c)
A. 1. (c), 2. (a), 3. (c), 4. (b)

B. 1. (F), 2. (T), 3. (T), 4. (F), 5. (T)
B. 1. (T), 2. (F), 3. (T), 4. (F)

C. 1. Desktop, 2. left, 3. computers, 4. Internet Explorer
C. Do yourself.

Activity Mania
D. 1. A keyboard has five types of keys.

My Document      ,   My Computer       ,
2. Keyboard is an input device which is used to type 

Internet Explorer      ,  Recycle Bin words and numbers on a computer.

3. (a) Arrow Keys, (b) Number Keys, (c) Alphabetic 
Keys, (d) Function Keys.

1. Computer...A Machine 4. Alphabetic keys are used to write sentences.

A.        Used to take us from one place to another place, Activity Mania

       Used to draw pictures,        Used to get cool air, Do yourself.
      Used to watch movies,     Used to keep vegetables 

5. Computer Mousefresh.

A. 1. (c), 2. (b), 3. (b), 4. (a)B. 1. man-made, 2. life, 3. electricity, 4. pictures

C. 1. FAST, 2. TIRED, 3. SUMS, 4. MISTAKES, 5. TIME B. 1. (F), 2. (F), 3. (T), 4. (T)

D. 1. Machine is a man-made thing which is made to C. 1. Computer mouse is a pointing device which is used 
save our time and to make our work easy. to select and draw.

2. Computer is a machine which runs on electricity.
2. Mouse pointer is an arrow on the screen.3. Computer helps us to do many useful tasks.

4. (a) Cooler, (b) Mobile, (c) Refrigerator, (d) Air-
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Activity Mania Activity Mania

Do yourself. 1. Fill with color tool, 2. Rectangle tool, 3. Pencil tool,
4. Line tool, 5. Eraser tool.

6. Operating the Computer
9. Behaving Well in Lab

A. 1. (c), 2. (b), 3. (b)
A. 1. (T), 2. (F), 3. (T), 4. (T), 5. (F)B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (F)
B. 1. (a) We should always keep the computer-room neat C. 1. Step 1 : Switch on the main switch for power 

and clean. (b) We should follow the proper steps to supply.
switch ON the computer.

Step 2 : Now, switch on the power button of the 
2. We should not eat or drink in the computer lab.UPS.
3. Because the dust of the shoes is harmful for Step 3 : Switch on the power button of the monitor.

computers.
Step 4 : Finally switch on the CPU.

4. When we cover computer, we protect it from dust.
2.

Activity Mania

Do yourself.

1. Computer — A Machine

A. 1. (c), 2. (c), 3. (b), 4. (b), 5. (c)

B. 1. electronic 2. things 3. to calculate 4. created

C. 1. A computer is an electronic machine that works on 
the principle of Input—Process—Output.Activity Mania

2. • Computer cannot take decisions on their own.Do yourself.

• Computer doesn’t have feelings and emotions.7. Storage Devices
3. • Computer works faster than human beings.

A. 1. (b), 2. (a), 3. (b), 4. (c)
• Computer never gets tired.

B. 1. (T), 2. (F), 3. (T), 4. (F), 5. (T)
4. Human beings are ahead of computers because—

C. 1. Floppy disk is a magnetic disk. It is used for storing 
• Human beings are creators of all machines as well small quantity of information.

as computers.
2. The shape of CD is round.

• Human beings can take decisions on their own.
3. Hard disk is a storage device. It is fitted inside the 

Activity ManiaCPU box.

A. 1. DESKTOP,  2. COMPUTER,  3. PALMTOP,4. Pen drive is the latest storage device.
4. LIMITATIONS

5. Hard disk is fitted inside the CPU box.
B. Do yourself.

Activity Mania

2. Parts of A Computer     Floppy Disk,            Pen Drive,

A. 1. (c), 2. (b), 3. (b), 4. (a), 5. (c)      Compact Disk,            Hard Disk

B. 1. (F), 2. (T), 3. (F), 4. (T), 5. (F)8. Drawing with A Computer
C. 1. Monitor looks like a TV. This device displays results 

A. 1. (c), 2. (a), 3. (b), 4. (a)
on the screen.

B. 1. (T), 2. (T), 3. (F), 4. (F)
2. Monitor, CPU, Keyboard, Mouse.

C. 1. Paint
3. Microphone is used to record your voice, music and 

2. You can open the Paint program by following steps: sound in the computer. 

Step 1 : Click on the Start button. Activity Mania

Step 2 : Choose All Programs. A. Do yourself.

Step 3 : Choose Accessories and click on Paint. B. Do yourself.

3. Pencil tool is used to draw freehand drawing.

Step 1 : Click on the Start button on the screen. A 
list of option will appear.

Step 2 : From the menu that appears, select option 
Shut down. Now wait for some time till the 
computer turns off automatically.

Step 3 : Switch off the power button of the monitor.

Step 4 : Now, switch off the power button of the 
UPS.

Step 5 : Finally, switch off the main power supply.

 IT Vision–2
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3. Spacebar key is used to give blank space between 3. Uses of Computers
the words.

A. 1. (c), 2. (b), 3. (b)
4. Four cursor control keys are there on a keyboard.

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T)
Activity Mania

C. 1. Three special features of computers are —
Do yourself.

(i) Computer works faster than human beings.

6. Handling A Mouse(ii) Computer never gets tired.

A. 1. (a), 2. (b), 3. (c), 4. (c)(iii) Computer never makes mistakes.

B. 1. (F), 2. (F), 3. (T), 4. (T), 5. (T)2. — at school

C. 1. Pointing device is used to select anything on the (i) Computers help to prepare test papers and 
monitor screen. Mouse is a pointing device.report cards.

2. To click, place the pointer on any icon, press the left (ii) Computers maintain the records of books in the 
mouse button once and release it. It will select an library
icon. This is known as clicking.

— at home
3. Press left mouse button on the icon. Keeping it 

(i) Computers help us to do our home work. pressed, move the mouse on the pad. This process 

(ii) Computers help us to enjoy games, music and is known as dragging.

movies. Activity Mania

— in office Do yourself.

(i) Computers help to type and print important 
7. Let’s Paint

documents.
A. 1. (c), 2. (a), 3. (a), 4. (b)(ii) Computer shelp to send and receive e-mails.
B. 1. (T), 2. (F), 3. (T), 4. (F)Activity Mania
C. 1. Pencil tool is used to draw freehand drawing.BANK, SCHOOL, OFFICE, HOSPITAL, HOMES, 

AIRPORTS 2. Line tool is used to draw straight lines in Paint.

3. Fill with color tool is used to colour drawings.4. How A Computer Works
Activity ManiaA. 1. (c), 2. (b), 3. (a), 4. (b)

A. (a) BRUSH, (b) PENCIL, (c) TEXT, (d) TOOL BOX, B. 1. (T), 2. (T), 3. (F), 4. (T)
(e) RECTANGLE

C. 1. The calculations and making decisions are called 
B. Do yourself.processing.

8. Microsoft Windows2. Output devices display the results on computer 
screen. A. 1. (b), 2. (a), 3. (c), 4. (a)

3. Because all the processing and calculation in B. 1. (T), 2. (F), 3. (T), 4. (T)
computer is done by CPU.

C. 1. Operating System is a software program that 
4. Input devices are used to feed data and instructions provides an interface between user and the 

in computer. computer softwares.

Activity Mania 2. In Windows operating system we can perform many 

A. 1. Input, 2. Output, 3. Process, 4. Process, 5. Output functions like solving sums, playing movies, reading 
books, etc.B. Do yourself.

3. Desktop, icons, taskbar, start button, recycle bin 
5. Keyboard and my documents are some components of 

A. 1. (b), 2. (c), 3. (a), 4. (b) Windows.

B. Do yourself. 4. My documents is the personal folder for storing 
data so it is useful for us.C. 1. (F), 2. (T), 3. (T), 4. (F), 5. (T)

Activity ManiaD. 1. Alphabetic keys are used to write a word or a 
sentence on computer screen. Do yourself.

2. Backspace key is used to erase anything typed on 
the left of the cursor.
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 IT Vision–3 2. Operating system is a software program that 
provides an interface between hardware and 
software components of computer system.1. All About Computers

3. My Documents, Computer, Recycle Bin, Network. A. 1. (b), 2. (c), 3. (a), 4. (a), 5. (c)

4. To change the position of taskbar, follow these B. 1. (b), 2. (d), 3. (e), 4. (f), 5. (c), 6. (a)
steps :C. 1. (T), 2. (F), 3. (T), 4. (T), 5. (F)

D. 1. Computer is an electronic system that is made of 
devices that help you enter data, process it, store it 
and output the results.

2. CPU is called the brain of the computer.

3. The components of central processing unit are —

(i) Arithmetic and Logic Unit (ALU)

(ii) Control Unit (CU)

(iii) Memory Unit (MU)

4. ALU performs all the arithmetical and logical Activity Mania
operations.

1. (e), 2. (c), 3. (a), 4. (b), 5. (d)
5. Memory unit of computer is used to store data.

4. Notepad
2. Storing the Computer Work

A. 1. (c), 2. (a), 3. (b), 4. (c), 5. (a)
A. 1. (b), 2. (a), 3. (c), 4. (a), 5. (b)

B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (F)
B. 1. (b), 2. (c), 3. (c), 4. (a), 5. (d)

C. 1. Notepad is a software program that allows you to 
C. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T) write on the computer.

D. 1. Computers have memory in which data and 2. To start Notepad application, select Start > All 
information are stored. Programs > Accessories > Notepad

2. Two types of memory are found in computer — 3. Maximize button

(i) Primary memory   (ii) Secondary memory 4. Elements of Notepad window are as under.

3. Secondary storage devices are needed to store • Title Bar • Minimize Button  • Menu Bar • Maximize 
bulk information that you can use over a long time. Button • Working Area • Close Button

4. (i) Hard Disk, (ii) Pen Drive, (iii) CD (Compact Disk) 5. Scroll Bars

5. Hard Disk is the main storage device of the Activity Mania
computer which is fitted inside the CPU box. The 

Do yourselfhard disk consists of a set of magnetically coated 
disks placed one upon another and mounted 5. Working with Paint
together on a rotating hub.

A. 1. (b), 2. (c), 3. (a), 4. (c)
Activity Mania

B. 1. (F), 2. (T), 3. (T), 4. (F), 5. (T)
A. 1. Random Access Memory

C. 1. Line tool
2. Read Only Memory

2. To open an already saved drawing, follow the given 
3. Compact Disk steps :

4. Digital Versatile Disk

5. Giga Byte

B. 1. PRIMARY, 2. BRAIN, 3. ROM, 4. PERMANENT,
5. BYTES, 6. GIGA BYTE, 7. BITS, 8. ROM

3. Operating System : Windows 7

A. 1. (b), 2. (c), 3. (c), 4. (b), 5. (c)

B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (T)

C. 1. Some elements of Windows are icons, taskbar, 
start button, etc.

Step 1 : Move the mouse pointer on the taskbar.

Step 2 : Click the right mouse button and select 
Properties option.

Step 3 : A window will appear on the screen. In 
window, click on the list in front of Taskbar location 
on screen and select the desired option say : Right.

Step 4 : Click on OK button.

Hence position of taskbar will be changed on the 
screen.

Step 1 : Click on the Paint button and select Open 
option from the drop-down menu. An Open dialog 
box will appear.

Step 2 : Select the File name that you want to 
open.

Step 3 : Click on Open button.

3. To save a drawing, follow the given steps :

Step 1 : Click on the Paint button. Select Save 
option from the drop-down menu.
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Step 2 : The Save As dialog box appears.

Step 3 : Type the file name in the File name text 
box.

Step 4 : Click on Save button. The file will be 
saved. Step 1 : Click in the Input box at the bottom of 

MSW LOGO commander.4. Polygon tool is used for drawing different types of 
polygons. Step 2 : Type the command, say, FD 100.

5. Text tool is used to write text on paint screen. Step 3 : Press the Enter key to execute the 
command.

1. A word processor is a software that helps you to 
type text on a computer screen.

2. Quick access toolbar provides us with access to 
commands that we frequently use.

3. Save option is used to save a file in MS Word.

4. The steps to save a document are :

Step 1 : Click on the Office Button and select Save 
option.

Step 2 : The Save As dialog box will be displayed.

Step 3 : Type the file name in the File name text 
box.

Step 4 : Click on the Save  button.

Hence, your file will be saved.

5. To close any document follow these steps :

Step 1 :  Click on the Office button.

Step 2 : In the drop–down list, click on Close 
option.

4. Command input box is used for typing the 
commands.

5. To execute the commands in MSW LOGO, follow 
the given below :

Activity Mania
Activity ManiaA. 1. Rectangle tool, 2. Text tool, 3. Airbrush tool, 4. 

Polygon tool, 5. Fill with color tool. 1. (e), 2. (a), 3. (b), 4. (c), 5. (d)

B. 1. CURVE, 2. TEXT, 3. AIRBRUSH, 4. POLYGON, 8. Mobile Computers
5.  BRUSH

A. 1. mobile operating system, 2. smartphones, 3. laptop 
6. Introducing Microsoft Word 4. Android

A. 1. (c), 2. (b), 3. (b), 4. (b) B. 1. (v), 2. (i), 3. (iii), 4. (iv), 5. (ii)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T) C. 1. With a smartphone we can —

C. 1. Vertical, 2. Cursor, 3. Exit Word, 4. Ribbon, 5. • Listen to music • Take pictures • Play games
Status • Search information • Read electronic books or e-

booksD. 
2. In a tablet, input is given to a touchscreen by using 

a finger or a pen-like device called stylus.

3. Do yourself.

1. Input and Output Devices

A. 1. (c), 2. (b), 3. (b), 4. (a), 5. (c)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (T)

C. 1. The device through which we enter data and 
instructions into a computer is called input device. 
Two input devices are mouse and keyboard.

2. The devices that are used to select objects, text on 
the screen are called pointing devices. Mouse and 
lightpen are pointing devices.

3. A device through which we see the output from the 
computer is called output device. Two commonly 
used output devices are monitor and printer.

4. (i) The printed copy that we get from the computer Activity Mania
is called hard copy.

Do yourself.
(ii) The output that we get on the monitor screen is 

7. Introducing LOGO called soft copy.

A. 1. (b), 2. (a), 3. (c), 4. (b), 5. (c) 5. A microphone is used to input sound/voice into the 
computer while a speaker is used to output sound B. 1. (T), 2. (F), 3. (T), 4. (F), 5. (T)
from the computer.

C. 1. LOGO is a simple language used to draw figures, 
6. Monitor is the most commonly used output device. write text and do simple calculations.

It is also called Visual Display Unit (VDU)
2. MSW LOGO screen is divided into two sections :– • 

2. Working with Windows-7Main Screen • Commander Window.

3. The main screen is the area where pictures are A. 1. (b), 2. (a), 3. (c), 4. (c), 5. (a)
drawn. B. 1. (T), 2. (T), 3. (T), 4. (T), 5. (F)

IT Vision–4
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C. 1.

Activity Mania

A. Do yourself

B. 1. Rename, 2. File,  3. Two,  4. New,  5. Copy

3. Advanced Features of Paint

A. 1. (a), 2. (a), 3. (a), 4. (a)

B. 1. (F), 2. (T), 3. (T), 4. (T), 5. (F)

C. 1. Select tool, 2. Free-form Selection tool,
3. Flip/Rotate, 4. Flip, 5. Resize

D. 1. We can select a picture using Free-form Selection 
tool, by following these steps :

To create a folder, follow the given steps : Step 4 : Right click anywhere on the new location 
and click on Paste option.Step 1 : Click the right mouse button where you 

want to create a folder. 3. Notepad, Calculator, Paint and WordPad.

Step 2  : A submenu appears. Choose the New 4. To rename a file, follow the given steps :
option. Step 1 : Right click on the file to be renamed.
Step 3 : Click the Folder option. Step 2 : Choose the Rename option.
Step 4 : Type the folder name. Step 3 :  The file name will turn blue and cursor will 
Step 5 : Press the Enter key. be displayed.

2. To create a file, follow the given steps : Step 4 : Type the new name that you want to give 
to the file.Step 1 : Go to the folder in which you want to 

create a file. Step 5 : Press the Enter key.

Step 2 : Click on File menu. 5. To open a file or folder, simply move the mouse 
pointer to the required file/folder and double-click Step 3 : Choose New option. A list of options will 
on it. The file/folder will open and you can view its appear on the screen.
contents.

Step 4 : Click on Text Document.

Step 5 : Specify the name of your file.

Step 6 : Press the Enter key.

3. To copy a file, follow the given steps :

Step 1 : Right click on the file, you want to copy.

Step 2 : Choose the Copy option.

Step 3 : Move the mouse pointer where you want 
the file to be copied.

Step 4 : Right click anywhere on the screen.

4. To rename a file, follow the given steps :

Step 1 : Right click on the file to be renamed.
Step 1 : Select the Free-form Selection tool in the 

Step 2 : Choose the Rename option. Image group.

Step 3 :  The file name will turn blue and cursor will Step 2 : To select the object, place the pointer on to 
be displayed. Drawing area.

Step 4 : Type the new name that you want to give Step 3 : Press and hold down the left mouse button 
to the file. and drag the pointer to select the part of the 

drawing.Step 5 : Press the Enter key.

Step 4 : Release the mouse button after selecting 5. When a file or folder is useless, you want to delete 
the drawing.it. To delete a file, follow these steps :

2. Flip/Rotate option is used to flip or rotate an object.Step 1 : Right click on file to be deleted.

3. To resize a picture horizontally, follow the given Step 2 : Click on Delete option.
steps :

Step 3 : Windows confirms before deleting the file 
Step 1 : Click on the Select tool and select the by showing a dialog box.
picture.

Step 4 : Click on Yes button.
Step 2 : Select the Resize option in the Image 

D. 1. A file is a collection of data stored in a storage 
group on the Home tab. Resize and Skew dialog 

device and a folder is a named memory space to 
box appears on the screen.

keep files.
Step 3 : In the Resize section type percentage or 

2. To move a file, follow these steps :
number of pixels in Horizontal text box.

Step 1 : Right click on the file, you want to move.
Step 4 : Click on OK button.

Step 2 : Choose the Cut option.
4. The Skew option allows you to change one end of 

Step 3 : Move the mouse pointer where you want the drawing while the other end is fixed.
the file to be moved.

5. MS Paint has two selection tools. They are Select 
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tool and Free-form Selection tool. 3. Left align, Center align, Right align, Justify align.

4. Border and shading can be applied to the text by 
following steps :

Step 1 : Select the text.

Step 2 : Click on the drop-down arrow next to the 
Border button in the Paragraph group on the Home 
tab. Select Borders and Shading option. The 
Borders and Shading dialog box appears on the 
screen.

Step 3 : Under Setting section, click on Box option.

Step 4 : Under the Style section, select the line 
style.

Step 5 : Select the Colour and Width.

Step 6 : Click the drop-down arrow of Apply to 
section and select the Paragraph option.

Step 7 : Click on OK button and observe the 
Step 1 : Select the text that you want to copy. change.

Step 2 : Click on the Copy button in the Clipboard 5. To change the font colour, the steps are :
group on the Home tab.

Step 1 : Select the text that you wish to colour and 
Step 3 : Place the cursor at the location where you click on Home tab.
want to paste the text.

Step 2 : Click on the triangular drop-down arrow 
Step 4 : Click on the Paste button in the Clipboard next to the Font Color. button on the Home tab. It 
group on the Home tab. will open a list of colours.

4. The steps to select a paragraph in MS Word are : Step 3 : Select the desired colour from the 
displayed colours. The colour of the text will be Step 1 : Place the cursor to the left of the first 
changed.character to be selected.

6. Alignment is the way of placing the text between Step 2 : Hold down the left mouse button and drag 
margins of a page.it to a position where you want to stop selection.

Step 3 : Release the mouse button.

Step 4 : The selected text gets highlighted.

To change font type and font size, follow the given 
steps :

Step 1 : Select the text for which you want to 
change font type or font size.

Step 2 : To change the font size, click on Font Size 
drop-down arrow in the Font group and select any 
font size.

Step 3 : To change the font type, click on the drop-
down arrow present next to the Font Style box and 
select the desired font from the displayed list.

Activity Mania

A. 1. (b), 2. (d), 3. (e), 4. (a), 5. (c)

B. Do yourself.

4. Editing Text in MS Word

A. 1. (a), 2. (b), 3. (b), 4. (a), 5. (c)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T)

C. 1. To make changes in your document, you have to 
first select the text in the document.

2. To delete a block of text in MS Word, follow the 
given steps:

Step 1 : Select the block of text is to be deleted.

Step 2 : Press the Delete key.

3. The steps for copying and pasting text are :

Activity Mania

1. (c), 2. (d), 3. (f), 4. (a), 5. (b), 6. (g), 7. (e)

Activity Mania 6. LOGO Primitives

1. (b), 2. (d), 3. (e), 4. (a), 5. (c) A. 1. (b), 2. (a), 3. (b), 4. (a), 5. (c)

B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (T)5. Formatting Text in MS Word

C. 1. LOGO commands are known as primitives.A. 1. (b), 2. (a), 3. (c), 4. (b), 5. (b), 6. (c), 7. (c)

2. FD command draws a line in the forward direction B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F)
for the given number of units.

C. 1. Formatting is the general arrangement of text. It 
3. HOME command brings the turtle to the starting helps in changing the appearance of text by using 

position.various fonts, colours, sizes and styles.

4. SETH command, followed by a number, turns the 2.
turtle towords the clockwise direction, no matter 
which way the turtle head is pointing.

5. CLEAN command is used to erase the entire 
drawing from the screen but there is no change in 
the position of the turtle.

Activity Time

A. 1. (ii), 2. (iv), 3. (i), 4. (vi), 5. (iii), 6. (v)

B. 1. Clear Screen, 2. Forward, 3. Backward, 4. Show 
Turtle, 5. Clear Text, 6. Hide Turtle.
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7. Arithmetic Operations in LOGO

A. 1. (c), 2. (c), 3. (a), 4. (b), 5. (a)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (F)
Activity Time

C. 1. PRINT, 2. PR, 3. CT, 4. Quotient, 5. arithmetic
A. 1. (d), 2. (c), 3. (a), 4. (b)

D. 1. PRINT “ARNAV
B. 1. Video, 2. Sound, 3. Photographs, 4. Animation,

2. Four arithmetic operations are used in LOGO. They 5. Text.
are : Additon (+), Subtracion (–), Multiplication (*) 

9. Introducing Internetand Division (/).

A. 1. (b), 2. (a), 3. (c), 4. (b), 5. (a)3. To add more than two numbers using the sum 
operator, the numbers have to be written in round B. 1. (T), 2. (F), 3. (F), 4. (T), 5. (T)
brackets like : PR (SUM 37 23 15)

C. 1. Internet is a worldwide network of networks.
4. Quotient function takes two inputs. It divides the 

2. Some of the uses of internet are as follows :
first number by the second and given the quotient 
as the result.

5. Clear text command is used to clear the text 
screen.

Activity Mania

A. Do yourself.

B. 1. (d), 2. (a), 3. (b), 4. (c)

8. Multimedia

A. 1. (c), 2. (a), 3. (c), 4. (b)

B. 1. (F), 2. (F), 3. (F), 4. (T), 5. (T)

C. 1. Multimedia is an application that combines and 
executes text, sound, video, animation and 
graphics simultaneously.

2. Windows Media Player is a multimedia application. 
It is used to listen to an audio or a video CD on the 
computer.

3. To start Windows media player, follow the given 
steps : Activity Time

Step 1 : Click on the Start button. A. 1. World Wide Web

Step 2 : Select All Programs. 2. Uniform Resource Locator

Step 3 : Click on Windows Media Player. 3. Electronic-mail

4. Education, Advertising, Playing games and 4. Internet Service Provider
Creating presentations.

B. Do yourself.
5.

1. Computer Generations

A. 1. (b), 2. (c), 3. (b), 4. (b), 5. (a)

B. 1. (F), 2. (T), 3. (F), 4. (T), 5. (T), 6. (F), 7. (F)

C. 1. (d), 2. (e), 3. (a), 4. (b), 5. (c)

D. 1. Pascaline was the first mechanical calculator. It 
consisted of a box with eight movable wheels. 
Using Pascaline addition, subtraction, multiplication 
of numbers as big as hundreads, and thousands 
could be easily done.

2. Analytical engine was the first general purpose 

Animation : It is the series of moving pictures with 
slightly different movement so as to create an 
illusion of movement.

• You can read your study material on the Internet.

• You can send and receive e-mail with the help of 
Internet.

• You can purchase a product through Internet.

• You can chat with people on the Internet.

• You can read news on Internet.

• You can get information on any topic through 
Internet.

3. A website is a collection of related web pages 
containing information related to a certain topic.

4. (a) There is no charge for sending and receiving 
email through internet. (b) Email is a quick method 
than the ordinary postage.

5. Websites and web pages are stored on powerful 
computers. These computers has very high 
capacity to keep information or data. These 
computers are known as web servers.

Different components of a multimedia file are :

Text : It is the textual data in the form of alphabets,  
numbers and symbols.

Sound : It is the data in the form of voice and 
speech.

Picture : It is the data in the form of images like 
graphics and clip arts.

Photographs : These are actual still pictures.

Video : These are actually moving pictures or 
images.

Graphics : It is the creation and manipulation of 
static images or pictures.

 IT Vision–5
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computer. This machine had the same basic 3. Features of MS Word
elements as the modern computers : input, output 

A. 1. (c), 2. (a), 3. (b), 4. (a), 5. (b)
and memory devices.

B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (F)
3.

C. 1. Thesaurus are used to find synonyms for the words 
typed in the document.

2. To change the text to lower case, follow the given 
steps :

Step 1 : Select the text for which you want to 
change case.

Step 2 : Click on Change Case button in the Font 
group of Home tab. A list of options will appear on 
the screen.

Step 3 : Select lowercase option.

3. (i) Sentence case, (ii) lower case, (iii) upper case,
(iv) Capitalize each word, (v) Toggle case.

4.

Activity Mania

A. 1. Sir John Napier, 2. Gottfried Von Leibnitz, 3. 
Charles Babbage,  4. Howard Aiken,  5. Blaise 
Pascal.

B.  Do yourself.

2. Software and Its Types

A. 1. (b), 2. (c), 3. (a), 4. (c)

B. 1. (T), 2. (F), 3. (F), 4. (T), 5. (F)

C. 1. Software is the collection of programs that are 
stored and run on computer hardware and help 
users to work on the computer. Software is of two 
types —

(a) System Software  (b) Application Software

2. An operating system controls the overall activities 
of a computer. It acts as a link between the user 
and the hardware and enables them to work 
together.

The main functions of an operating system are 
device management and memory management.

3. Utility programs perform specific tasks usually 
related to managing a computer, its devices or its 
programs.

4. Word processing software helps us to create 
professional looking documents quickly and 
efficiently. In word processing software we can 
easily add, delete, rearrange or beautify the text.

Activity Mania
5. Multimedia software is used to create video, 

A. 1. Find, 2. Proofing, 3. Ctrl+F,  4. Paragraph,
animation, sound, graphics and text with a high 

5.  Ctrl+Shift+L
degree of interaction.

B.  Do yourself.
Activity Mania

4. Working with Tables in MS Word1. (iii), 2. (i), 3. (v), 4. (ii), 5. (iv)

A. 1. (c), 2. (c), 3. (a), 4. (a), 5. (a), 6. (b)

The third generation computers used Integrated 
Circuits, popularly known as chips, instead of 
transistors. These computers were smaller in size 
as compared to second generation computers. 
Capacity of main memory was greatly enlarged in 
these computers. These computers used an 
operating system that allowed machines to run 
many different programs simultaneously. Example : 
IBM 370, Honeywell 2000.

4. Difference Engine and Analytical Engine.

5. In 1821, Charles Babbage invented a machine 
called the Difference Engine to prepare 
mathematical tables. This machine used punch 
card that is the basic concept of modern computer 
and because of this invention, Charles Babbage is The steps to add bullets to existing text are :
known as the Father of Computer.

Step 1 : Select the text.

Step 2 : Click on the Bullets button in the 
Paragraph group on the Home tab.

Step 3 : Choose the style that you want to use for 
the bullets in the list.

5. The steps to find text in a document are :

Step 1 : Select Home tab. Click on the Find button 
in the Editing group. A menu appears on the 
screen.

Step 2 : Select the Find option in the menu. Find 
and Replace dialog box appears on the screen.

Step 3 : In the Find what box, enter the text that 
you want to search and press Enter key.

Step 4 : Click the Find Next button to find the next 
occurrence of the given text. If MS Word finds the 
text, it will highlight the text or word in the 
document.

Step 5 : Repeat step 4 until MS Word has finished 
searching the document.

Step 6 : When the search is finished, a Message 
box will appear. Click on OK button on the Message 
box.

Step 7 : Select the Highlight All option of Reading 
Highlight button. The given words will be 
highlighted in the entire text.

Step 8 : Close the Find and Replace dialog box.
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B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (T)

C. 1. Table is the combination of rows and columns. 
Tables are used to organize and manage data in 
tabular form.

2. 3. Word Art button is located on Insert tab.

4.

Activity Mania

Do yourself..

6. Windows 7

Activity Mania A. 1. (a), 2. (b), 3. (a), 4. (b), 5. (c)

1. Table, 2. Insert, 3. Insert Below, 4. Table, 5. Alt+O+B B. 1. (F), 2. (T), 3. (F), 4. (T), 5. (T)

C. 1. Operating system is a software program that 5. Working with Objects in MS Word
provides an interface between hardware and 

A. 1. (b), 2. (c), 3. (c), 4. (b), 5. (b) software components of computer system. 
B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (T) Windows 7 is the latest version of windows 

operating system.C. 1. Clip Art is a gallery of pre–designed pictures that 
can be inserted into a document. Clip Art gallery 2. When you want to save your time in accessing 
consists of several categories of clips. commands or accessing any program, you use 

shortcut menu also known as context menu.2. Word Art is a feature of MS word that allows you to 
create some special effect and unique look to the 3. The steps of creating shortcut of Notepad program 
text. are :

Step 1 : Move on Start > All Programs > 
Accessories > Notepad

Step 2 : Right click on the Notepad option.

Step 3 : A pop–up menu with a list of options 
appears on the screen.

Step 4 : Select Send to option, another cascading 

with a selected placeholder text.

Step 4 : Choose the Font and Size of your text.

Step 5 : Type the text in the blank area and click on 
the OK button.

The steps to create a table in a document are :

Step 1 : Place the cursor on the work area where To insert a picture from file, follow the given steps :
you want to create a table.

Step 1 : Place the cursor at the position where you 
Step 2 : Select the Insert tab. Click on the Table want to insert your picture.
button in the Tables group.

Step 2 : Click on Picture button in the Illustrations 
Step 3 : A menu will appear on the screen. Select group on the Insert tab.
the Insert Table option. The Insert Table dialog box 

Step 3 : The Insert Picture window appears. Select gets displayed.
the desired picture file.

Step 4 : Specify the number of rows and columns 
Step 4 : Click on the Insert button.in the dialog box.

5. Shapes is a drawing feature that helps you to draw Step 5 : Click on OK button.
different shapes like stars, banners, callouts, 

3. The steps to merge cells are : connectors, etc.
Step 1 : Select the cells you want to merge. 6. To write text in a shape, follow the given steps :
Step 2 : Click on Layout tab. Click on Merge Cells Step 1 : Place the cursor at the position where you 
button in the Merge group. want to write text in a shape.

4. To steps to delete a column of a table are as under Step 2 : Select a shape of your choice from the 
: Shapes drop-down menu.
Step 1 : Select the column you wish to delete. Step 3 : Drag the selected shape in the document 
Step 2 : Click on Delete button on Rows & according to your need.
Columns group Step 4 : Now right click on the drawing object and 
Step 3 : Select Delete Columns option from the select the Add Text option from the shortcut menu.
menu. Step 5 : Insertion point appears in the object. Now 
Step 4 : Click on OK button. you can type the text in the document. 

5. Border is a black solid line around all the table 
cells. MS Word applies a 0.5 point black solid line 
border around all the table cells. Shading is the 
style of border.

To insert WordArt in a document, follow the given 
steps :

Step 1 : Select the Insert tab.

Step 2 : Click on WordArt button in the Text group. 
Choose a WordArt style from the given grid.

Step 3 : The Edit WordArt Text window appears 
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menu appears on the screen. 8. Introducing MS PowerPoint
Step 5 : Now click on Desktop (create  shortcut) A. 1. (b), 2. (a), 3. (b), 4. (c), 5. (c), 6. (b)
option.

B. 1. (F), 2. (T), 3. (T), 4. (F), 5. (T)
Step 6 : Click on any blank space on desktop or 

C. 1. Slides are the individual pages of a MS PowerPoint 
press Esc button.

presentation.
4. The right pane consists of the following items :

2.
Current user, Documents, Pictures, Music, Games, 
Computer, Control Panel, etc.

Activity Mania

Do yourself.

7. LOGO Procedures

A. 1. (b), 2. (b), 3. (c), 4. (a), 5. (c)

B. 1. (F), 2. (T), 3. (T), 4. (F), 5. (F)

C. 1. A procedure is a set of instructions written one after 
the other to perform a particular task and referred to 
by a name.

2.

Activity Mania

1. (e), 2. (c), 3. (d),  4. (a),  5. (b)

9. MS PowerPoint : Working With Text 

A. 1. (b), 2. (a), 3. (a), 4. (c), 5. (b), 6. (b)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T)

C. 1.

Activity Time

Do yourself.

To start Microsoft PowerPoint, follow the steps 
given below:

Step 1 : Click on Start button.

Step 2 : Select All Programs option.

Step 3 : Point on Microsoft Office. A sub-menu 
appears.

Step 4 : Now click on Microsoft Office PowerPoint 
2007. The Microsoft PowerPoint window appears.

3. PowerPoint is a presentation software It is used to 
create professional presentations.

4. To save a presentation, follow the steps given below 
:

Some rules which you must follow while naming the 
Step 1 : Select Save option of Office button drop-procedure name are :
down menu.

? The first character should always be a letter. 
Step 2 : The Save As dialog box appears on the For example, Bag, A326, etc.
screen.

? Blank spaces should not be used. For example, 
Step 3 : Type the file name in the File name text ‘Red Square’ is an invalid name.
box.

? Arithmetic operators +, –, *, / cannot be used in 
Step 4 : Click on Save button.the name. For example, ‘A*BC’ name is invalid.

5. To close a presentation, follow the steps given ? Logo primitive’s names should not be used in 
below :procedure name. For example, ‘FD’ name is 

invalid. Step 1 : Click on the Close option of Office button 
drop-down menu.3. To erase a procedure, select Erase option of the 

File menu in MSW LOGO window. A box will Step 2 : If the file has not been saved, MS 
display on the screen. Click on the procedure name PowerPoint will display a dialog box asking you to 
which you want to delete and click OK button. save the changes you have made.

4. To recall a saved procedure, LOAD command is • Click Yes if you want to save the changes done 
used with the syntax LOAD ‘Procedure Name’. in the presentation.

5. A LOGO procedure has three parts : (i) Title line, • Click No if you don’t want to save the changes 
(ii) Body, (iii) End line. done in the presentation.

6. To save a procedure, follow the steps given below : • Click Cancel if you want to return to the 
presentation.Step 1 : Click on the File menu of MSW LOGO 

screen.

Step 2 : Select Save option from the File menu.

Step 3 : The Save As dialog box appears.

Step 4 : Type the name for the file in the File name 
text box and add ‘.lgo’ extension in the Save as 
type box.

To place text anywhere on a slide, you first need to Step 5 : Click on Save button.
add a new text box.

The steps to add a new text box on the slide are :

Step 1 : Select Insert tab.

Step 2 : Click on Text Box button on the Text group.
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Step 3 : Move the cursor to the place on the slide 
where you want  to add the text box.

Step 4 : Hold down the left mouse button. Drag the 
mouse down and to the right to draw the text box.

Step 5 : Release the mouse button, when the text 
box is of desired size. Primary Memory : This memory is also known as 

Main Memory. Primary memory is used as a form 2. (i) Sentence case, (ii) lower case, (iii) upper case,
of temporary memory for calculation processes and (iv) capitalize each word, (v) toggle case.
storage of temporary values that need rapid access 

3. Mouse pointer takes the  |  shape. or updating. The contents of the primary memory 
disappear when the power is turned off. Primary 4. If you want bulleted list in your slide then follow 
memory is important while executing programs. these steps:
Bigger programs require more primary memory.

Step 1 : Select Home tab.
Secondary Memory : This memory is also called 

Step 2 : Click on Bullets button drop-down menu in 
auxiliary memory or back-up memory. Secondary 

the Paragraph group.
memory is used for the storage of most of the 

Step 3 : A list of options will appear on clicking the system’s data, programs and all other permanent 
drop-down menu. Select Bullets and Numbering data that should stay there even when the power is 
option. turned off. As a computer is fed with bigger, smarter 

programs and more data, it would naturally need Step 4 : Bullets and Numbering dialog box will 
more secondary memory to hold them.appear on the screen. Select an appropriate layout 

of bullets or numbering that you want and click on 3. (i) Random Access Memory (RAM) 
OK button.

• The CPU uses this memory while processing 
5. The steps to delete text from a slide are : information.

Step 1 : Select the text that you wish to delete. • This is also called read/write memory.

Step 2 : Press Delete key on the keyboard. • This memory is temporary in nature.

Hence, selected text will be deleted from the slide. (ii) Read Only Memory (ROM) 

• ROM contains a basic set of instructions called 
the Basic Input-Output System which helps to 
start the operating system.

• It is a memory unit that can only be read from.

• It is a permanent memory.

4. A computer has a very large internal memory. It can 
store a vast amount of information and can recall 
that information instantly and correctly whenever 
desired. The memory of a computer can be 
classified into primary memory and secondary 
memory.

5. Output devices are used to get result or information 
from the computer system. These devices convey 
information from the computer to the user. Two 
commonly used output devices are monitor and 
printer.

6. A light pen is a pointing device shaped like a pen 
and is connected to a monitor. A light pen consists 

B. 1. (F), 2. (F), 3. (T), 4. (T), 5. (F)

C. 1. The input and output devices attached to a 
computer are called computer peripherals. 2. 
Memory is of two types :
(i) Primary Memory (ii) Secondary Memory 

Activity Mania

1. F7, 2. Proofing, 3. Home, 4. Toggle case, 5. New 
slide button.

10. Algorithm and Flowchart

A. 1. (T), 2. (T), 3. (F), 4. (T), 5. (T)

B. 1. Algorithm is a set of instructions that uses a step by 
step description of the procedure.

2. A flowchart is a representation of a problem–solving 
process, in which steps are laid out in a logical 
order.

3. Decision box is used when one needs to choose 
between options and the condition of Yes/No 
arises.

4. Process box is used for writing processes or 
actions for example, multiplying two numbers.

5. Flow lines are used to show the flow of logic in a 
flowchart.

Activity Mania

Do yourself.

1. Computer Peripherals

A. 1. (a), 2. (c), 3. (b), 4. (d), 5. (d)
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of a photocell mounted on a   pen-shaped tube and Step 3 : Collect all the remainders, i.e. from the first 
is capable of sensing a position on the screen remainder (LSB– Least Significant Bit) to the last 
when its tip touches the screen. remainder (MSB—Most Significant Bit) and put 

them together to get the binary equivalent.
2. Number System

Step 4 : Arrange all the binary digits from MSB to 
LSB.

6. Octal Number System : Number system made up 
C. 1. All through your primary schooling, your teachers of eight symbols,  0 to 7, is known as the Octal 

must have made you count from 1 to 100, then 101 Number System.
to 200 and so on. But, your counting must have 

When this system is in use, every number is formed 
followed a set pattern. All that you had to do was to 

using 0, 1, 2, 3, 4, 5, 6 and 7. Since formation of 
learn 10 new symbols, that is 0, 1, 2, 3, 4, 5, 6, 7, 8, 

numbers involves the use of these eight symbols, 
9. Beyond 9, all the numbers were generated by 

the base of the octal number system is said to be 8. 
using these 10 symbols in various combination. 

The symbols 0 to 7 are known as octal digits.
The system of representing numbers that is used 

E. 1. (a) 2 39 (b) 2 79the world over is known as the decimal number 
system. Thus, number system is the method of 

2 19 1 2 39 1
counting.

2 9 1 2 19 1
2. Number system made up of only two symbols, 0 

and 1, is known as the Binary Number System. 2 4 1 2 9 1

When this system is in use, every number is formed 2 2 0 2 4 1
using 0 and 1. Since formation of numbers involves 

1 0 2 2 0the use of these two symbols, the base of the 
binary number system is said to be 2. The symbols 1 0
0 and 1 are known as binary digits or bits in short.

(39)   =  (10011) (79)   =  (1001111)10 2 10 2

3. Number system made up of ten symbols, 0 to 9, is 
(c) 2 143 (d) 2 49known as Decimal Number System.

2 71 1 2 24 1When this system is in use, every number is formed 
using 0, 1, 2, 3, 4, 5, 6, 7, 8 and 9. Since formation 2 35 1 2 12 0
of numbers involves the use of these ten symbols, 

2 17 1 2 6 0the base of decimal number system is said to be 
10. The symbols 0 to 9 are known as decimal 2 8 1 2 3 0
digits.

2 4 0 2 1 1
4. Binary addition is performed in the same manner as 

2 2 0decimal addition. Binary number system has only 
two digits (0,1) and the addition table is given below : 1 0

0 + 0 = 0 (143)   =  (10001111) (49)   =  (110001)10 2 10 2

0 + 1 = 1
2. (a) (1100) (b) (10001)2 2

1 + 0 = 1
3       2     1       02 2 2 2 16   8   4     2    1

1 + 1 = 0 and carry over 1
8    4    2    1 1     0   0     0    1

Example :   Add (1000)  and (101)2 2

1    1    0    0
1 0 0 0

8 + 4 + 0 + 0 = 12 16 + 0 + 0 + 0 + 1 = 17
+  1 0 1

(1100)   =  (12) (10001)   =  (17)2 10 2 10 1 1 0 1 =  (1101)2 

(c) (11111) (d) (10001)2 2(1000)  + (101) =  (1101)2 2 2 

16    8    4    2    1 16 8   4    2    15. To convert the decimal number  to a binary number, 
follow the steps given below : 1      1    1    1    1      1      0   0    1    1

Step 1 : Divide the decimal number by 2. 16 + 8 + 4 + 2 + 1 = 31 16 + 0 +0 + 2 + 1 = 19

Step 2 : Proceed the division with divisor till you get (11111)   =  (31) (10011)   =  (19)2 10 2 10
0 as dividend.

A. 1. (c), 2. (a), 3. (c), 4. (b), 5. (d)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F), 6. (F)

+ 

0

+
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3. (a) 11001 (b) 10001 5. Performing a mail merge, involves three basic 
steps :

10101 1110
1. Creating the main document : This contains 

= (101110) = (11111)2 2 the standardized text that will be printed on all the 
merged documents. The main document has a (c) 11100 (d) 1001
merge field. This is a place holder which instructs 

10011 1111
where and what will be inserted from the data 

= (101111) = (11000) source.2 2

2.  Creating the data source : This is a file which 
contains the variable data that is to be inserted in 
the document. In the above case, the addresses of 
all the persons to whom letters have to be sent, will 
form the variable data that is stored in the data 

To change the paper size, follow the given steps : source.

Step 1 : Select the Page Layout tab. Click the 3.  Merging the data source and the main 
Margins button in the Page Setup group. A drop- document.
down list of options appears.

6. Creating a Recipient list involves three steps :
Step 2 : Select the Custom Margins option. The 

Step 1 : Click the option Type a new list under Page Setup dialog box will appear.
Select recipients and then click at Create to get a 

Step 3 : Select the Paper tab in the Page Setup New Address List dialog box.
dialog box.

Here, type the details of the first recipient. You can 
Step 4 : Select a predefined paper size from the leave the fields blank, if not required. After typing 
Paper size drop-down list. or You can also specify the details of first entry, click at New Entry button to 
the width and height of your paper in which the get the next blank form. After typing all the entries, 
page is being printed in Width and Height boxes. click on Close button. Save Address List dialog box 

appears. Type the desired name and click on Save Step 5 : Click on OK button to apply the selected 
button.new settings to your document.

Step 2 : Mail Merge Recipients window appears 2. Paragraph alignment means the way of placing the 
which shows the data you have entered. You can paragraph between the margins of a page.
edit the data you want.

3. To print a document, follow the given steps :
Step 3 : Click on OK button.

Step 1 : Click on the Office Button and move 
mouse on the Print option.

Step 2 : Click on the Print option. The Print dialog 
box opens.

Step 3 : In the Printer section, you can select the 
printer to be used for printing, in the Name drop-
down list.

Step 4 : Page range section allows you to choose 
the pages to be printed. You can print all pages of 
the document, current page or you can specify the 
range of pages, e.g., 6–12, for consecutive pages 
and specify individual pages using comma ‘,’ 
operation in the Pages box.

Step 5 :  In the Copies section, specify how many 
To insert SmartArt in your presentation, follow the 

printouts you want to take of your document.
given steps :

Step 6 : Press OK button to get the printouts of 
Step 1 : Select a slide from your presentation 

your document.
where the SmartArt has to be inserted.

4. Header is the text that is printed at the top of each 
Step 2 : Click on SmartArt button in the Illustrations 

page in the document, whereas footer is the text 
group on Insert tab.

printed at the bottom of the page in the document.

1

3. Using Mail Merge

A. 1. (b), 2. (c), 3. (c), 4. (d), 5. (a)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F)

C. 1.

4. MS PowerPoint Presentation

A. 1. (c), 2. (b), 3. (c), 4. (c), 5. (b)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (F)

C. 1. A slide is the individual page of the presentation to 
which you can add text, colours, pictures and 
sound.

2. MS PowerPoint is the most commonly used 
software for creating presentations. It is widely used 
in offices for creating business presentations. It is 
one of the members of microsoft office family and 
also in schools for creating presentations on 
different topics.

3.
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Step 3 : Choose a SmartArt Graphic dialog box To apply colour scheme to the slide, follow the given 
appears on the screen. Select a type of SmartArt steps :
from the available list.

Step 1 : Open your presentation and choose the 
Step 4 : Click on OK button after selecting suitable slide whose colour scheme you want to change.
SmartArt.

Step 2 : Move the mouse over a theme in the 
Step 5 : SmartArt will be inserted on the slide. Now Themes group on Design tab.
you can add text inside the SmartArt diagram 

Step 3 :  Select the desired theme. The theme will 
according to your requirements.

be applied to all the slides.
4. To change theme of your presentation, follow the 

Step 4 : Click on Colors button in the Themes 
given steps:

group and select the colour scheme of your choice.
Step 1 : Select Design tab.

Step 5 : To apply the colour scheme to :
Step 2 : Scroll the mouse over the available 

• all the slides, right-click on the colour 
themes and select the desired theme under 

scheme and select the Apply to All 
Themes group. The selected theme will be applied 

Slides option.
in your presentation.

• the selected slide, right-click and select 
Step 3 : For more themes, click on the More drop-

the Apply to Selected Slides option.
down arrow at the bottom right corner of Themes 
group.

Step 4 : A drop-down menu will appear. In the 
drop-down menu, you can select theme of your 

To change slide layout, follow the given steps :choice.

Step 1 : Choose the slide whose layout you want to 5. To create a presentation using built-in template, 
change in your presentation.follow the given steps :

Step 2 : Click on Layout button in the Slides group Step 1 : To start MS PowerPoint, select Start > All 
on the Home tab.Programs > Microsoft Office > Microsoft Office 

PowerPoint 2007. Step 3 : A drop-down list appears on the screen 
called the Layout drop-down list with various Step 2 : Click on New option of the Office Button 
layouts.drop-down menu. The New Presentation dialog box 

will appear. Step 4 : Select the layout according to your 
requirements and observe the changes in your Step 3 : Click on Installed Templates option under 
slide.Templates section.

6. To apply texture to the background, follow the given Step 4 : Select a template of your choice from the 
steps :Installed Templates section and click on Create 

button. Step 1 : Click on Background Styles button, present 
in the Background group on Design tab. A list of Step 5 : The selected template opens as a new 
options will be displayed.presentation. The new presentation contains various 

slides, illustrating different slide layout, backgrounds, Step 2 : Click on Format Background option. The 
themes, etc. Format Background dialog box will appear on the 

screen.6. Templates are the sets of pre–designed formats 
that include text, layouts, colour schemes, pictures, Step 3 : Click the required radio button, say, Picture 
sound etc. that help in creating a beautiful or texture fill.
presentation.

Step 4 : Select the various options according to 
your choice and click on Apply to All button.

Step 5 : Close the Format Background dialog box.

Microsoft is well-known for continuously improving 

3. 

4. Each slide has its own layout, called slide layout, 
Layout refers to the way, the things are organized 
on a slide.

5.

5. Working With Slides

A. 1. (a), 2. (b), 3. (d), 4. (a), 5. (c)

B. 1. (T), 2. (F), 3. (T), 4. (F), 5. (F) 6. More on Windows 7
C. 1. Normal view is divided into three panes – Outline A. 1.  (b), 2. (d), 3. (a), 4. (c), 5. (d)

pane, Slide pane and Notes pane.
B. 1. (T), 2. (F), 3. (F), 4. (F), 5. (T)

2. Notes pane is used to add the information you want 
C. 1.to share with the audience.
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the various features of Windows, and this has lead programs one by one. The PowerPoint window is 
to many versions of it. After the arrival of many active as present.
versions of Windows 1, 2 and 3, the company 

Step 2 : Now, right-click anywhere on the blank 
brought out Windows 95 and Windows 98. 

portion of the taskbar.
Windows ME (Millenium Edition) was released after 

Step 3 : A list of options will appear on the screen.Windows 98, which adopted the features of both 
the Windows 98 and Windows 2000. Windows XP Step 4 : Click on Show Windows side by side 
and Windows Vista were later developed in this option from the shortcut menu. Both the application 
series. The most recent version is called the windows will be displayed side by side.
Windows 7.

2. Windows 7 has its six different editions. These are :

• Windows 7 Starter

• Windows 7 Home Basic

Microsoft Excel is an electronic spreadsheet. It is • Windows 7 Home Premium
an application software that helps in calculation 

• Windows 7 Professional using formulae and analysis of data using tables. It 
allows you to arrange data into rows and columns. • Windows 7 Enterprise
It also facilitates speedy and accurate mathematical 

• Windows 7 Ultimate calculations.

3. Aero Shake, Aero Snap, Aero Peek, Sticky Notes. 2. Three types of data can be entered in an MS Excel 
worksheet :  • Number     • Text     • Formulae4. Pinning allows easy tracking and opening of an 

application. Any application can be pinned to the Number
task bar by dragging and dropping it on to task bar. 

Number data is formed with numeric digits 0–9 and You can also right-click on the shortcut of an 
is used for the calculations. By default numbers are application in the Start menu and select the option 
right aligned in a cell.‘Pin in the taskbar’.

TextTo remove the pinned application from task bar, just 
right click on the specified pinned icon on the task Text data consists of alphabets, combination of 
bar and click ‘Unpin this program from taskbar’. alphabets, and numbers which cannot be used for 

the calculation. Text data is always left aligned in 5. Aero Snap
the cell.

Snap enables you to control the window size and 
Formulaelocation on your desktop. You can move a program 

window to the left or right of the desktop, maximize Formulae consists of mathematical operators and 
or minimize it just by moving it. cell address. You can enter formulae which will give 

‘answer’ after calculation, that is a number. It Aero Peek
always start with a ‘=’ sign. Example, ‘= A1 + B1’.

This feature helps you to view the desktop without 
3. There are 65536 rows and 256 columns in an Excel minimizing or closing programs. After viewing, you 

worksheet.can instantly bring the program windows back to 
their original positions. This is accomplished 4. Workbook is the collection of worksheets. Initially 
through a ‘Show Desktop’ button that appears at there are only three worksheets in a workbook but 
the right-most end of the task bar. you can insert as many as you want.

6. Jump list provides quick way to find the opened or 5. A cell is the smallest unit of a worksheet, formed by 
recently opened files. Do you remember the the intersection of a row and a column. Each cell 
‘Recent Documents’ in the previous version of has a unique address formed by the combination of 
Windows? Yes, jump list resembles the same a column letter and a row number.
feature. However, jump lists are grouped by the 

6. To edit data, perform the following steps :program to which the file belongs. This allows you 
to open files from the same taskbar button that you Step 1 : Select the cell that you wish to edit.
use to open the program.

Step 2 : Double click on it or press F2 key. Either 
7. To display two application windows at the same way, the cursor is positioned at the end of the 

time, follow the given steps : content of the cell. Use the Backspace key to 
remove one character at a time.Step 1 : Open MS PowerPoint and MS Excel 

7. Microsoft Excel 2007

A. 1. (c), 2. (a), 3. (d), 4. (b), 5. (c), 6. (b)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (T), 6. (F)

C. 1.
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Step 3 : However, to remove the entire content of a Step 3 : A submenu appears on the screen. Click 
cell, start typing the new content by selecting the on Insert Sheet Rows option to insert a new row 
cell. The old content is replaced by the new one. and Insert Sheet Columns option to insert a new 

column.
7. The cell having a dark border, is called the active 

cell. You work in one ‘active cell’ at a time. The 5. The Undo command allows you to reverse that last 
border around the active cell is called the cell action you have performed. Redo command is used 
pointer. to quickly repeat the last action that you have done 

using Undo command.

6. MS Excel’s Autofill feature lets you enter a 
predefined series of data such as text or  numbers 
quickly in a worksheet. It can be applied in a 
worksheet by using following procedure.

After you have entered data into a cell, you can 
Step 1 : Enter the first two values of the data in make changes in it. There are two ways in which 
adjacent cells. The first two data values determine you can edit the cells data : (i) By overwriting cell 
the increment value and the starting number for the contents  (ii) By modifying cell contents partially
series.

2. Row height is automatically adjusted in MS Excel if 
Step 2 : Select the two cells.you enter taller characters. But, to manually change 

the height of a single row, click on the bottom Step 3 : Click the AutoFill handle (a small black 
border of the row–heading and drag it up or down. square) in the lower right corner of the selected 

cells and drag it down to enclose the area you want To change the height of several rows at once, follow 
to fill with the number series.the given steps :

Step 4 : Release the mouse button. The cells Step 1 : Select the required rows for which you 
enclosed in the gray border will be filled with the want to change height.
desired number series.

Step 2 : Click on Format button in the Cells group. 
D. 1. Ctrl + Z, 2. Ctrl + Y, 3. Ctrl + C, 4. Ctrl + V, 5. Ctrl + AA menu appears. Select Row Height option.

Step 3 : A dialog box appears called Row Height 
dialog box.

Step 4 : Enter the new height of the current rows 
and click on OK button.

QBASIC is the simplest, interactive high-level 
3. To change the width of several columns at once, 

programming language. It was developed in 
follow the given steps :

Dartmouth College, USA, under the direction of 
Step 1 : Select the required columns for which you Professors John G. Kemeny and Thomas E. Kurtz, 
want to change width. in 1964. Though it was developed as a beginner’s 

language, it has become very popular due to its Step 2 : Click on Format button in the Cells group. 
simplicity.A menu appears. Select Column Width option.

2. Numeric Data : Numeric values on which Step 3 : A dialog box appears called Column Width 
mathematical operations such as addition, dialog box.
subtraction, multiplication, division, etc. can be 

Step 4 : Enter the new column width in the Column performed are called numeric data.
width text box and click on OK button.

String Data : The data that do not perform any 
4. When you need to add a row or column in a mathematical operation except additon (+) but can 

worksheet which is already created, follow the be used for comparison are called string data.
given steps :

3. Logical operators are used to combine two or more 
Step 1 : Select the row immediately below the point relational expressions to produce a single value 
where you want to insert a new row. To insert a new which can be either true or false. NOT, AND, OR 
column, select the column to the right of the point of are the logical operators.
insertion. You can select the entire row by clicking 

4. Arithemtic Operators : An arithmetic operator on the row header or the column header to select 
works on numeric constants and variables and the entire column.
always gives a numeric output.

Step 2 : Click on Insert button drop-down menu in 
Relational Operators : A relational operator is the Cells group on Home tab.

8. Editing A Worksheet in Excel

A. 1. (c), 2. (d), 3. (a), 4. (b), 5. (d), 6. (d)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (F)

C. 1.

9. Introducing QBasic

A. 1. (b), 2. (a), 3. (d), 4. (c), 5. (a)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (F)

C. 1.

18



used to compare the values of two or more click the option ‘Compose’ on the left side of the 
constants or variables. account screen. A message screen will appear.

5. To save a program in QBASIC, follow the given Step 3 : In the To box, type the e-mail address of 
steps : the person to whom you want to send mail. Write 

your message in the large empty box.
Step 1 : Select Save option from File menu.

Step 4 : Click on Send button.
Step 2 : The Save dialog box appears. Select the 
required drive and directory. 5. (a) www.yahoomail.com

Step 3 : Type the file name. An extension .BAS will (b) www.gmail.com
be automatically generated.

(c) www.rediffmail.com
Step 4 : Click on OK button.

6. URL (Uniform Resource Locator) : Uniform 
6. To open already saved program in QBASIC, follow Resource Locator is the address or location of a 

the given steps : website on the Internet. To visit a website, type the 
URL of the website in the address bar and then 

Step 1 : Select Open option from the File menu.
press the Enter key. URL of some websites are :

Step 2 : The Open dialog box appears. This dialog 
• http://www.ncert.nic.in   • http://www.discovery.com

box shows a list of all the BASIC files of the current 
directory. Select the required drive, directory and • http://www.google.com
file.

Web Page : The individual pages which collectively 
Step 3 : Click on OK option. form the World Wide Web are known as Web 

Pages. These pages contain text, graphics, audio, 
video and links to other pages.

These pages may contain text, often underlined and 
coloured, or a small image, called an icon.

The advantages of using an e-mail program are the 
following :

Speed : E-mail is far quicker than ordinary postage. 
A message can reach any part of the world in a 
fraction of a second.

Reliability : Since multiple copies of important files 
Cost : Nothing is charged for sending and receiving can be maintained and transferred between 
e-mail messages even though the message travels systems, the network ensures that any critical task 
across the world. does not come to a standstill or data is not lost if a 

machine stops working.Content : You can attach photos, videos or 
important data along with  your message. The Redundancy : Computer networks reduce the 
message may consists of only a few lines of text to need for hard copies of all documents. By sharing 
thousands of lines. files over the network, the need to share paper 

copies of reports or any other information can be Reliability : E-mail is the reliable mode of 
eliminated or greatly reduced.communication. It is more reliable than ordinary 

postage. Scalability : Adding more and more computers to 
an existing network is not a cumbersome process. 4. To send an e-mail, follow the given steps :
It just takes a few minutes. Similarly, the entire 

Step 1 : Open any e-mail website, say network does not collapse if just one client 
www.gmail.com and enter your e-mail address and computer stops working.
password.

3. LAN : LAN stands for Local Area Network. The 
Step 2 : The next screen will be you Inbox. Now LAN spans across a limited geographical area like 

10. Exploring Internet

A. 1. (c), 2. (b), 3. (c), 4. (d), 5. (b)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (T)

C. 1. Internet is a global network of computers, used for 
sharing information.

1. Computer Networking2. E-mail is an electronic mail sent from one computer 
to another. It is the most widely used application. It A. 1. (b), 2. (c), 3. (b), 4. (a), 5. (c)
is a facility on internet to compose, store, send and 

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (F), 6. (T)
receive messages to any part of the world.

C. 1. A computer network is a collection of computers 
3.

and the related devices connected using certain 
communication channels. These networks allow 
users to share the resources with other computers 
and also communicate between different machines.

2.

IT Vision–7
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a computer lab, office building, residential Octal Digits.
apartment or school and connects computers and 

2. To convert an octal number into a binary number, 
devices in that area. Wired LANs use ethernet 

follow the given steps :
technology, phone lines, coaxial cables or power 

Step 1 : Convert every octal digit into its equivalent lines to connect the computers. Your computer lab 
of 3 binary digits.is a classic example of LAN.

Step 2 : Combine all binary digits and make a WAN : WAN stands for Wide Area Network. It is a 
group.kind of network that covers large geographical area 

across the countries or continents. In WAN, two or 3. Hexadecimal number system is made up of sixteen 
more computers located at far away places are symbols, 0 to 9 and A to F. When this system is in 
connected to each other for communication. use, every number is formed using 0, 1, 2, 3, 4, 5, 

6, 7, 8, 9, A, B, C, D, E and F. Since formation of 4. A network topology is how computers, printers and 
numbers involves the use of these sixteen symbols, other devices are connected in a particular 
the base of the hexadecimal number system is said arrangement. It describes the layout of wires, 
to be 16. The symbols 0 to 9 and A to F are known devices and routing paths. It defines the 
as Hexadecimal Digits.arrangement patterns in which the terminals or 

nodes are connected with each other. 4. To convert a binary number into a hexadecimal 
number, follow the given steps :5. The Network Interface Card : A NIC is the 

computer’s gateway to the network. It attaches the Step 1 : Bunch binary digits into groups of four 
computer to the network allowing it to communicate starting from the rightmost digit. 
with the other computers on the network.

Step 2 : If the leftover binary digits do not add up to 
Modem : A device which is needed to translate four, add 0s to the left.
between the analog phone line and digital 

Step 3 : Convert every set of four binary digits into computer, is called a modem. Modems are formally 
its equivalent hexadecimal digit.known as modulators demodulators. It modulates a 

digital signal from the computer into an analog one 5. To convert a decimal number into a hexadecimal 
to send data out over the phone line. number, follow the given steps :

6. Star Topology : One of the most popular Step 1 : Divide the decimal number by 16. Note 
topologies for Ethernet LANs is the star. It is easy down the quotient and the remainder.
to set up and it is relatively cheap. The star 

Step 2 : Divide the quotient obtained by 16 and topology works by connecting each node to a 
note down the resulting quotient and remainder.central device. This central connection allows us to 

have a fully functioning network even when other Step 3 : Repeat the procedure till you reach a 
devices fail. The only real threat to this topology is quotient less than 16.
that if the central device goes down, the entire 

Step 4 : List all the remainders moving from bottom network goes down. Star topology is better suited 
to top.for small networks.

D. 1. (a) (100111010)2Ring Topology : In local area networks where the 
ring topology is used, each computer is connected 100 111 010
to the network in a closed loop or ring. The signal 

4 7 2passes through each machine or computer 
connected to the ring in one direction only. There is = (472)8

no central node in this pattern of topology. The 
(b) (101111101)2disadvantage of this topology is even if one node 

fails, the whole network stops working. 101 111 101

5 7 5

= (575)8

(c) (11100010011)2

Octal number system is made up of eight symbols, 011 100 010 011
0 to 7. When this system is in use, every number is 

3 4 2 3formed using 0, 1, 2, 3, 4, 5, 6 and 7. Since 
formation of numbers involves the use of these = (3423)8

eight symbols. The symbols 0 to 7 are known as 

2. Number System

A. 1. (c), 2. (a), 3. (d), 4. (c)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (F), 6. (F)

C. 1.

0 0 0

0 0 0

0 0 0 0
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(d) (1110011) 2. To insert WordArt on the slide, follow the given 2

steps :
001 110 011

Step 1 : Click the WordArt button in the Text group 
1 6 3

on Insert tab.

= (163)8 Step 2 : WordArt gallery drop-down menu appears 
on the screen. Click on the required WordArt style.2. (a) (12FC)16

Step 3 : A placeholder appears on the screen with    1    2    F    C
sample text ‘Your Text Here’. In the placeholder, 

0001 0010 1111 1100 type something say ‘Signature Books International’.

= (0001001011111100)2 Step 4 : Select the typed text and click on Text Fill 
drop-down arrow in WordArt Styles group on the (b) (643A2)16

Format tab. Select the desired colour for your text 
6 4 3 A 2 and observe the change.

    0110 0100 0011 1010 0010 Step 5 : Click on Text Outline drop-down arrow. 
Choose the desired outline colour from the = (01100100001110100010)2
displayed list.

(c) (15FA)16 Step 6 : Click on Text Effects drop-down arrow and 
click on the desired effect you want to give to your 1 5 F A   
text.

0001 0101 1111 1010
3. Shapes is a drawing feature that helps to draw 

= (0001010111111010)2 different shapes like Stars, Banners, Flowcharts, 
Callouts, etc.(d) (A36C)16

To insert shapes on the slide, follow the given steps  A   3    6   C
:

     1010 0011 0110 1100
Step 1 : Open the slide on which you want to insert 

= (1010001101101100)2 shape object.

Step 2 : Click on Shapes button in Illustrations 
group on the Insert tab.

Step 3 : Shapes drop-down menu appears on the 
screen with various shapes like Lines, Rectangles, 
Block Arrows, Callouts, etc.

Clip Art is used to add pictures in the slides. You Step 4 : Select the category and from the different 
can add Clip Art images to the existing slide and shapes of that category, click one that you want to 
enhance its appearance. draw.

To insert Clip Art in your presentation, follow the Step 5 : Bring the mouse pointer on the slide and 
given steps : drag diagonally to draw the shape of desired size.

Step 1 : Open the slide and place the cursor on Step 6 : To resize a shape, select the shape by 
which you want to insert the Clip Art image. clicking on it. It displays eight handles on the 

object. Place the mouse pointer on any handle. The Step 2 : Click on the Clip Art button in the 
pointer changes to double-headed arrow. Drag the Illustrations group on Insert tab.
handle to increase or decrease the size of shape.

Step 3 : Clip Art task pane will appear on the right 
4. To write text in a shape, follow the given steps :side of the window.

Step 1 : Select the shape on which you want to Step 4 : In the Search for text box, type the word or 
write text.phrase of the picture you want to insert and click on 

Go button. Step 2 : Right-click on the shape. A list of options 
will appear on the screen. Click on Edit Text option.Step 5 : It will display the list of Clip Art images 

related to your typed word or phrase. Step 3 : Cursor will appear on the middle of shape. 
Now write the text on the shape.Step 6 : Click on the desired Clip Art to insert it in 

the slide. Hence, you can write text on your desired shape.

0 0 0

3. Adding Graphics and Objects in MS 
PowerPoint

A. 1. (d), 2. (c), 3. (b), 4. (d), 5. (d)

B. 1. (F), 2. (T), 3. (F), 4. (T), 5. (F), 6. (T)

C. 1.
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+

5. To insert a table in a presentation, follow the given Step 2 : Select the Insert tab.
steps :

Step 3 : Click the drop-down arrow on the Sound 
Step 1 : Open the slide on which you want to insert button in the Media Clips group. A pop-up menu 
a table. appears on the screen.

Step 2 : Click on Table button in the Tables group Step 4 : Select the Sound from File option from the 
on Insert tab. A list of options appears on the pop-up menu.
screen.

Step 5 : The Insert Sound dialog box will appear on 
Step 3 : Select the Insert Table option. The Insert the screen.
Table dialog box gets displayed on the screen.

Step 6 : Locate the sound file on your computer 
Step 4 : Specify the number of rows and columns and click on Open button.
in the dialog box and click on OK button.

Step 7 : Another dialog box named Microsoft Office 
6. A chart is a graphical presentation of data. It is an PowerPoint will appear on the screen displaying the 

effective way to display data in pictorial form. message : ‘How do you want the sound to start in 
Charts make it easier to show comparison, growth the slide show?’
and relationship among the values in data.

Step 8 : Here, you can either click on Automatically 
7. To create a chart in PowerPoint, follow the given or When Clicked button. Automatically option will 

steps : start the sound automatically as soon as the slide 
appears in slide show view, while When Clicked 

Step 1 : Open the slide on which you want to 
option will start the sound only when you click the 

create a chart.
mouse.

Step 2 : Click on Chart button in the Illustrations 
3. To insert your own sound in a slide, follow the given 

group on Insert tab.
steps :

Step 3 : Insert Chart dialog box gets displayed. 
Step 1 : Open or navigate the slide on which you 

Select the chart of your choice and click on OK 
want to insert your own sound.

button.
Step 2 : Select the Insert tab.

Step 4 : The chart will be displayed with a 
datasheet that contains the default data. You  can Step 3 : Click the drop-down arrow on the Sound 
enter your own data in the datasheet. To delete all button in the Media Clips group. A pop-up menu 
the data from the datasheet, move the mouse appears on the screen. Select the Record Sound 
pointer to Blank button. option from the pop-up menu.

Step 5 : The mouse pointer changes into a large Step 4 : The Record Sound dialog box appears. By 
plus sign ‘+’ of white colour. Click on the button and default, the sound will be named ‘Recorded Sound’.
press the Delete key to delete the data.

Step 5 : Press the red button to record, and square 
Step 6 : Type the table in the worksheet whose button to stop the recording.
data you want to see in chart form.

Step 6 : After recording of your sound, you can use 
Step 7 : As you enter the data, the chart gets the play button to listen to the recorded sound.
plotted automatically.

Step 7 : Click on OK button. A small speaker icon 
Step 8 : To close the datasheet, click on the Close will appear on the slide.
button on the Title bar.

4. The steps to print a presentation are :

Step 1 : Specify the slides to be printed.

Step 2 : Choose number of copies in the Number 
of copies box.

Step 3 : Specify the item that you want to print in 
Print what option.

Step 4 : You can make other changes in your 
printouts using Handouts option.To add sound or music file in a slide, follow the 

given steps: Step 5 : After making desired changes, click on OK 
button. Step 1 : Open or navigate the slide on which you 

want to insert sound file. 5. Think about a cartoon film. When one scene ends; 

4. Advanced Features of MS PowerPoint

A. 1. (b), 2. (c), 3. (d), 4. (b), 5. (a)

B. 1. (F), 2. (F), 3. (T), 4. (F), 5. (T), 6. (F)

C. 1. Animation is the process where multiple images are 
displayed rapidly in a sequence such that the 
images appears to be in motion.

2.
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another scene begins. For example, a scene can 4. The steps to apply border are as follows :
fade out into a new scene or the first scene slides 

Step 1 : Select the range of cells in the worksheet 
off the screen as the second slides in. The way one 

whose border style you want to change.
slide follows the other on the screen is called 

Step 2 : Click on Border button arrow in the Font transition. Such transitions are also available in MS 
group on Home tab and select More Borders option PowerPoint.
from the list.

6. To add slide transition to a slide, follow the given 
Step 3 : Format Cells dialog box appears on the steps :
screen.

Step 1 : Click on the desired slide, to which you 
Step 4 : Click on the Border tab in Format Cells want to add slide transition effect.
dialog box.

Step 2 : Click on the Animations tab.
Step 5 : Choose the different options of your 

Step 3 : By default, No Transition is applied to each 
choice.

slide. Click on any transition effect from the 
Step 6 : Click on the OK button.Transition to This Slide group.

5. The steps to format numbers are as follows :Step 4 : The current slide will display a preview of 
the selected effect. Step 1 : Select the cell or range of cells whose 

data you want to format.Step 5 : Select the desired speed from the 
Transition Speed drop-down list. Step 2 : Click on Number launcher button in the 

Number group.Step 6 : Click on the Transition Sound drop-down 
arrow and select any sound effect of your choice. Step 3 : The Format Cells dialog box appears with 

the Number tab as an active tab.Step 7 : Click on the On Mouse Click checkbox if 
you want to advance the slide manually by clicking Step 4 : Choose the category according to your 
the mouse or click on Automatically After checkbox choice. Under Number, you have the facility to 
if you want the slide to advance automatically to the choose the number of decimal places you want, 
next one. you can decide to use a thousand separator for 

larger numbers, and you can decide how you want Step 8 : Click on Apply To All button to apply the 
negative numbers to be represented.selected effects on all the slides.

Step 5 : After choosing options according to your 
choice, click on OK button. 

6. To change pattern and colour of the selected cells, 
follow the given steps :

Step 1 : Select the cell or range of cells.

Step 2 : Click on Format button in the Cells group 
on Home tab. A drop-down list appears on the 
screen. Click on Format Cells option.

Step 3 : Format Cells dialog box appears on the 
screen with Fill as an active tab.

Step 4 : Select a pattern from the Pattern Style To create a number series, follow the given steps :
drop-down list. The Sample box indicates how the 

Step 1 : Enter the first two values of the data in the pattern will look with the currently selected colour.
adjacent cells. The first two data values determine 

Step 5 : You can also change the colour of the the increment value and the starting number of the 
pattern. Select the pattern colour from Pattern series.
Color drop-down list.

Step 2 : Select the two cells.
Step 6 : Click on OK button.

Step 3 : Click the AutoFill handle (a small black 
square ‘   ’) in the lower right corner of the selected 
cells and drag it to enclose the area you want to fill 
with the number series.

Step 4 : Release the mouse button.

5. Formatting Data in MS Excel

A. 1. (b), 2. (c), 3. (d), 4. (a), 5. (c), 6. (c)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F), 6. (T)

C. 1. Alignment refers to the position in which data is 
placed with in the boundary of a cell.

2. The process of determining how data should be 
presented and how it will appear on a printed page is 
called formatting. Formatting changes the 
appearance of data but does not affect the actual 
cell value.

3.

6. Formulas in MS Excel

A. 1. (b), 2. (a), 3. (c), 4. (b), 5. (d)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T), 6. (F)

C. 1. The expression which helps you to calculate and 
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analyse the data in your worksheet is known as 
formula. A formula may contain cell addresses, 
operators and functions.

2.

7. Creating Charts in MS Excel

A. 1. (d), 2. (c), 3. (a), 4. (a), 5. (c)

B. 1. (F), 2. (F), 3. (F), 4. (T), 5. (T), 6. (F)

C. 1. A chart is a pictorial representation of data. Chart is 
an effective way to display data in pictorial 
representation of selected worksheet information.

2. MS Excel supports various types of charts. Some 
of them are Column Chart, Bar Chart, Line Chart, 
Pie Chart, Scatter Chart, Area Chart, Radar Chart, 
etc.

3.

Step 4 : Select a field, for example, ‘AVERAGE’ 
from the Sort by list box.

Step 5 : Select the option of your choice in Order 
It is convenient to use cell reference instead of list box.
actual data at the time of working with formula. For 

Step 6 : By default, My data has headers 
example, enter the formula ‘= A1 + A2’ instead of  ‘= 

checkbox is selected. If you do not have a header 
100 + 200’.

row, you can uncheck this option.
When you use cell reference and change a number 

Step 7 : Click on OK button to apply sorting in your 
used in a formula, Excel will automatically redo the 

data.
calculation for you. Let us consider a few examples 
of reference.

Bar Chart : This chart illustrates comparison 
among individual items. Categories are organized 
vertically, values horizontally, to focus on comparing 
the values and to place less emphasize on time. 

3. To edit a formula in your worksheet, follow the 
This is a chart with horizontal bars.

given steps :
Radar Chart : In radar chart, each data series has 

Step 1 : Double-click on the cell containing the 
its own value axis from the center point. There is a 

formula you want to change. The formula appears 
line which connects the value in the same data 

in the formula bar.
series.

Step 2 : Now you can edit the formula in the 
4. Data Points, Data Series, Chart Title, Data Labels, 

formula bar. Here, you want to see the addition, so 
Legend.

replace the (*) operator with (+) operator.
5. Data Points : The graphs are based on the values 

Step 3 : When you finish making the changes to 
of the worksheet. The values are known as data 

the formula, press the Enter key.
points. Data Series : The set of many data entries, 

4. which comes from the same row or column in a Functions are predefined formulas which are used 

worksheet, is called data series.to perform specific calculation.

6.5. To create a chart, follow the given steps :AutoSum feature is used for quickly summing the 
data values stored in a row or column. This feature 

Step 1 : Create a new worksheet with the data.
can be used by clicking AutoSum button, presented 

Step 2 : Select all the cells that will be in the chart in the Editing group on Home tab.
including headers.

6. Arranging a given set of data in a particular order is 
Step 3 : Click on the Insert tab.called sorting. This feature allows user to rearrange 

the given data in a specified order. Step 4 : Click on any chart type in the Charts group 
on Insert tab, say Column and select the chart sub-7. To sort data in Excel, follow the given steps :
type from the displayed choices.

Step 1 : Open the worksheet on which you want to 
Step 5 : The chart appears on the worksheet. A perform sort operation.
new category named as Chart Tools appears on the 

Step 2 : Select any cell in the worksheet and click 
Title bar.

on Sort button in the Sort & Filter group on Data 
Step 6 : Select the desired layout from the Chart tab.
Layouts group on the Design tab and observe the 

Step 3 : The entire database will be selected and 
change.

the Sort dialog box appears.
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Step 7 : Go to Chart Styles group and click on the WHILE......WEND LOOP
desired style. Observe the change in your chart. All 

Sometimes, a loop has to be executed repeatedly 
the data labels, legend details, mentioned in the 

while a given condition remains true. In such cases, 
selected data range will be displayed in the chart.

WHILE........WEND statement is used.
Step 8 : You can also change the data range of 

Syntax :WHILE condition
your chart after creating it. To change the data 

{range, right click on chart and click on Select Data 
from the shortcut menu. The Select Data Source Statement(s)
dialog box appears.

}
Step 9 : Make changes according to your choice 

WENDand click on OK button.

6. FOR ...... NEXT LOOP

FOR...... NEXT is an iterative statement. It is a 
fixed loop. It facilitates repeated execution of some 
QBASIC statements, a set number of times. It 
provides an easy way to create a loop.The INPUT statement allows the user to enter the 

value when the program is running. This command Syntax : FOR <control variable> = <initial value> 
will print and wait for the user to enter the value and TO <final value>
then assign this value to a variable. It is used like 

{statement}
this :

NEXT <control variable>
  Syntax : INPUT <Numeric or string variable 
name>

2. REM statement is used to give remarks in a 
program.

3. PRINT command is the output statement that is 
used to display the output on the computer screen.

Example     PRINT ‘‘HI’’ Robotics is the branch of engineering involved in 
the development and creation of machines capable HI will be displayed on the output screen.
of doing a given task automatically without any 

4. Output statement is used to display the output on human intervention, once it has been programmed.
the computer screen.

2. It is the study and design of an intelligent system 
5. Do yourself. that understands the environment around it and 

takes action accordingly. AI aims at simulating a 
machine like a human brain. Today, this is the most 
essential part of the technology industry, which 
provides solutions for the most difficult problems in 
computer science.

3. A rocket launching is the first phase of the flight of a 
rocket. For launching into interplanetary space, 
rockets are launched from a launch pad, which is 
usually a fixed location on the ground. Computers 
are used at the design stage of the project and in 
all phases of development right through to the flight 
control of the rocket.

4. On today’s generation ATMs, the customer is 
recognised by inserting a plastic ATM card with a 
magnetic stripe or a plastic smart card with a chip 
that contains a unique card number and some 
security information. Nowadays by using an ATM, 
customers can access their bank accounts in order 
to make cash withdrawals and check their account 
balances as well as purchasing other things.

5.

8. QBasic Statements

A. 1. (c), 2. (a), 3. (b), 4. (d), 5. (a)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (F)

C. 1.

1. Computer Technology

A. 1. (b), 2. (d), 3. (b), 4. (c), 5. (a)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F), 6. (T)

C. 1.

9. QBasic : Looping Statements

A. 1. (c), 2. (b), 3. (d), 4. (a), 5. (d), 6. (b)

B. 1. (T), 2. (T), 3. (T), 4. (T), 5. (F)

C. 1. Relational operators are used to perform a 
comparison between two values. The result of the 
comparison is either true or false.

Logical operators are used to either concatenate or 
reverse condition. Logical operators are useful 
when you need to check multiple conditions.

2. Looping means repeated execution of a statement 
or a set of statements. A loop is said to be a set of 
instructions that are executed more than once in a 
program.

3. STEP clause in FOR-NEXT is used to change the 
increment value.

4. The three ways to execute loops in QBASIC are :

FOR...NEXT, DO.....LOOP, WHILE......WEND.

IT Vision–8
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5. Networking management and administration of within a specified range.
entire system of banking can be done only because 

8. Follow the given steps to sort data :
of IT. ATMs are used to manage and process 

Step 1 : Enter the data in the worksheet.information of the customers which is done 
because of IT. So, IT is useful in banks. Step 2 : Select any cell in the data list.

6. An optical computer is a computer that uses light Step 3 : Click on Sort button in the Sort & Filter 
instead of electricity (i.e. photons) to manipulate, group on Data tab. The entire database will get 
store and transmit data. Because of the selected.
fundamental different physical properties of 

Step 4 : The Sort dialog box appears. MS Excel photons, the basic principle used in optical 
usually assumes that you have a header row, i.e., computer is optics, to produce computer with 
first row of the data source, which is the title or performance and capabilities greater than those of 
heading for the selected data and the electronic computers. Optical computer technology 
corresponding option is already selected. If you do is still in the early stage.
not have a header row, you can uncheck the option 

To replace electronic components with optical ones, My data has headers.
an equivalent ‘optical transistor’ is required. This is 

Step 5 : Select a field : For example, ‘TOTAL’ from achieved using materials with a non-linear 
the Sort by list box.refractive index.

Step 6 : Select the Largest to Smallest option in 
Order list box. By default, the Smallest to Largest 
option is selected. 

Step 7 : The sorted data appears.

Database management systems have the following 
advantages which encourage people to use them to 
generate and maintain databases :

DBMS Reduces Duplication of Data : A DBMS 
stores data at a central location and minimizes data 
redundancy, that is, duplication of data.

To add records using form, follow the given steps :
DBMS Removes Inconsistencies : When the 

Step 1 : Select any cell and click on Form button in same data is stored at multiple places, they may fail 
the Quick Access Toolbar. The Sheet1 dialog box to match. A DBMS stores data at a central location. 
appears on the screen. Thus, it eliminates data inconsistencies by 

eliminating duplication of data.Step 2 : Click on New button to add a new record 
in your database. DBMS Facilitates Data Sharing : A DBMS stores 

data at a central location and makes data available Step 3 : Here you can type the information for new 
to more than one user at the same time.record.

DBMS Ensures Data Security : A DBMS stores Step 4 : Click on Close button to exit from data 
data at a central location and prevents form.
unauthorized access and manipulation of the data. 

5. AutoFilter and Advanced Filter. Thus, DBMS makes data secure.

6. Conditional formatting means highlighting or DBMS Ensures Data Integrity : A DBMS places 
emphasizing selected cells on the basic of a restrictions on the data entered in specific fields 
criteria. It allows you to set rules on how the cells and ensures that only valid data is stored. Thus, 
should be formatted. DBMS gurantees data integrity.

7. Data validation is used to restrict the cell entries 

2. Advanced Features of MS Excel

A. 1. (d), 2. (a), 3. (a), 4. (c), 5. (d), 6. (d)

B. 1. (T), 2. (F), 3. (F), 4. (T), 5. (T), 6. (T)

C. 1. A database is a collection of inter–related data 3. MS Access : An Introduction
which is systematically organized and stored in a 

A. 1. (a), 2. (b), 3. (a), 4. (c), 5. (b), 6. (a)computer system. Organized data is easy to access 
and work with. Data organization is done using a B. 1. (T), 2. (F), 3. (F), 4. (T), 5. (T), 6. (F)
specific data model. The model, widely used these 

C. 1. A database is a systematic collection of interrelated days, is the relational model.
data that is organized and stored in a computer 

2. Sorting feature allows you to view data in different system.
orders, i.e, Ascending or Descending. It is the most 

2.powerful feature of MS Excel.

3. Filtering is a quick and easy way to extract certain 
records or rows from a database created in MS 
Excel. Thus, it allows you to selectively block out 
data that you don’t want to see.

4.
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3. Field : Each column of information in a table is The steps to create a table in design view are as 
referred to as a field. It stores a particular category under :
of information. For example, the column titled 

Step 1 : Open the database in which you want to 
‘NAME’ is a field that stores the names of students 

create a table.
in a class. So, the information stored in a column is 

Step 2 : In Database window, select Create tab called field.
and click on Table Design button in the Tables 
group. The Table Design View window appears.

Record : Number of fields make one record. Each 
Step 3 : Here you can create whatever fields you 

row of information is called a record. For example, 
like and select the data types for each field.

Student’s Roll No., Name, Age and Address 
The Table Design View window consists of two indicate one record of a student.
areas :

4. To create a blank database, follow the given steps :
(a) The field grid pane, and

Step 1 : Open MS Access by clicking on Start > All 
(b) The field properties pane.Programs > Microsoft Office > Microsoft Office 

Access 2007. The field grid pane allows us to give the field 
names and specify the data type. Some description Step 2 : MS Access opens with the ‘Getting Started 
with each field could also be given, though this is with Microsoft Office Access’ window.
optional.

Step 3 : Select Blank Database template in the 
The field properties pane allows us to enter more New Blank Database section.
details for each field like size, validation rule, etc.

Step 4 : A Blank Database task pane appears on 
Step 4 : Enter the first field name in Field Name the right side of the window that prompts you to 
column. Press the Tab key to move to Data Type create a file.
column and select the suitable data type for its 

Step 5 : Specify the file name say, Students_ 
respective field.

Records, in the File Name text box.
Step 5 : Press the Tab key to move to the 

Step 6 : Change the path from the Browse button 
Description column. In this column, you can give 

next to the File Name text box, if required.
any comment related to the field, This is an 

Step 7 : Click on Create button. The database will optional step.
be created and the name of the database will be 

Step 6 : Press the Tab key again and the cursor 
displayed on the Title bar.

will move to the Field Name column in next row.
5. MS Access is a software designed by Microsoft for 

Step 7 : Repeat this procedure until you have 
creation and maintenance of databases. It is based 

created all of your fields.
on the relational database model. Hence, it is 

Step 8 : After creating all your fields, press ‘Ctrl + known as a relational database management 
S’ key combination to save your file.system.

Step 9 : The Save As dialog box appears. Type the 6. The steps to open an already existing database are 
Table Name and click on OK button.:

Step 10 : A new dialog box appears prompting you Step 1 : Select Open option of Office Button drop-
to create a primary key.down menu.

Step 11 : Click on No button.Step 2 : The Open window appears.

3. In datasheet view, we enter the actual data i.e., the Step 3 : Choose the location of the file.
records.

Step 4 : To open the desired file, double click on 
4. Design view allows more control over the table the file name in the window or select the file and 

structure.click on the Open button.

5. To set primary key in a table, follow the given steps 
:

Step 1 : Select the field to be used as primary key.

Step 2 : Click on the Primary Key button present in 
the Tools group on Design tab.

2.

4. MS Access : Tables

A. 1. (c), 2. (b), 3. (b), 4. (d), 5. (c), 6. (c)

B. 1. (F), 2. (T), 3. (T), 4. (T), 5. (F), 6. (T)

C. 1. A table is the combination of rows and columns. It 
is the fundamental building block of any database.
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6. Only text and number data type field size can be computers and collects information about users 
changed; all other data types have the predefined without their knowledge. Spyware programs 
size. For text, change the Field Size property option secretly monitor the user’s computing. They can 
by increasing or decreasing the number of collect various types of personal information such 
characters. In numeric field, change the General as internet surfing habits, visited web pages, and 
tab to any other in the properties pane. transmits that information in the background to 

someone else. Sometimes, they also change 
7. To delete a field, follow the given steps :

computer-setting that results in slow connection 
Step 1 : Double-click on the table to open it and speed and wrong functionality of other programs. 
click on View button on Datasheet tab. Select Spyware can also collect information about e-mail 
Design View option from the drop-down menu. addresses, passwords and even credit card 

numbers.Step 2 : Select the field to be deleted by clicking on 
the field selector.

Step 3 : Click on Delete Rows button in the Tools 
group on Design tab.

HTML is an acronym for Hyper Text Markup 
Language. It is the language of the World Wide 
Web. It is the computer language used to create 
hyper text documents. Hyper text documents are 
the documents that have hyperlinks. These 
hyperlinks connect documents at different locations 
simply by clicking on hyperlinks. There is no set Trojan Horse
order of doing things. The movement from one 

A Trojan Horse is a  malware, that is, a malicious document to another is hyper and not linear.
software. It seems to perform a useful function, but 

2. HTML is the most popular language for designing actually performs destructive functions such as 
web pages and websites. HTML has the following destroying the data stored in the computer, allowing 
features :an outsider illegal access to the system, etc. A 

Trojan horse usually does not replicate itself. Some • It is easy to learn and master.
well-known Trojans are Nuclear RAT, Bitfrost, Zlop, 

• It allows text, images and videos to be displayed Mocmex, Beast, etc.
on a web page.

Worm
• It determines how a web page with text, images 

A Worm is a computer program that replicates itself and videos appears on the web browser. It 
very fast and disturbs entire network. It enters to a delivers the contents to multiple platforms.
computer system through infected e-mails, 

3. (i) Container Tags : Container tags require an reproduces itself, sends copies of itself to other 
opening or ON tag and closing or OFF tag.computers through a network and chokes the 

network. It also causes permanent loss of data. OFF tags are written within the angular 
Some Worms that have brought networks down are brackets, but using a slash before the 
Happy 99,  Code Red, Nimda, Storm, etc. command.

3. An antivirus software is a software designed to For example :  <title>           HTML          </title>
protect a  system from viruses. In order to be 

                         ON tag            text            OFF  
effective, it must be run in the background at all 

tag
times. Antivirus software must be updated on a 
regular basis to ensure that the latest viruses are (ii) Empty Tags : Empty tags have only a starting 
also covered. tag. For example,  <BR> tag is used to break a 

line in a web page. There is no closing tag for 
4. Program Virus, Boot Sector Virus, Macro Virus.

<BR>. Similarly,  <IMG> tag inserts an image.
5. • Frequent hanging of the system.

4. Each HTML file begins with <HTML> tag and ends 
• Displaying a change in data against the filename with </HTML> tag. These are called the markers 

in the directory, when a virus modifies the file. for the browser to identify the spots where the 
document starts and ends. Within these tags, • Deleting or damaging files.
HTML file is divided in two sections :

6. Spyware is a type of Malware that is installed on 

6. HTML : An Introduction

A. 1. (c), 2. (d), 3. (b), 4. (a), 5. (b)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (T), 6. (T)
5. Computer Virus

C. 1.
A. 1. (b), 2. (c), 3. (a), 4. (b), 5. (d)

B. 1. (T), 2. (F), 3. (F), 4. (T), 5. (T)

C. 1. A computer virus is a destructive software created 
to harm a computer and damage its contents.

2.
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HEAD : The HEAD section contains information ignored by the browser. It helps in editing or 
about the document that is not displayed on the viewing the HTML code of a web page. It is a useful 
web page. tag for programmers.

BODY : The BODY section contains everything that Syntax : <COMMENT> .......... </COMMENT>
is displayed on the web page. It includes text, 

3. SIZE, WIDTH and COLOR are the three attributes 
graphics, etc.

used with horizontal rule tag.
So, the basic structure of an HTML page is :

4. Bold tag is used to give the Bold effect to the text. It 
<HTML> is a container element.

<HEAD> Syntax :  <B>The text is bold </B>

<TITLE>Title of the page is written here </TITLE>    Italic tag is used to give the Italic effect to the text. It 
HEAD tag is a container element. 

</HEAD>            Syntax :  <I>The text is italic </I>

<BODY> 5. The browser does not recognize formatting. If you 
want to start a new line, you need to insert a line 

The other tags which define the page are included 
break <BR> tag. This tag has no end tag. 

here.
Syntax : <BR>

</BODY>
<HR> tag is used to display a horizontal line across 

</HTML>
the web page. It is an empty element that has no 

5. To view an HTML document, follow these steps : end tag.

Step 1 : Open Internet Explorer or any other web Syntax :   <HR>
browser.

6. Some of the attributes of body tag are :
Step 2 : Press Ctrl + O key combination. The Open 

BGCOLOR : BGCOLOR attribute is used to 
dialog box will appear. Click on the Browse button. 

change the background colour of a web page. You 
A dialog box will appear.

can use the BGCOLOR attribute like this :
Step 3 : Choose the path where you have stored 

Syntax : <BODY BGCOLOR=“Green”>
your HTML document and select your file. Click on 
Open button. TEXT : TEXT attribute is used to set the colour of 

the text in the document. You can use TEXT 
6. The HEAD tag contains information about the 

attribute like this :
document, including its title, scripts used, style 
definitions, document description and links to pages Syntax :  <BODY TEXT = ‘‘White’’>
that could be pre-loaded. This tag is nested within 

TOPMARGIN : This attribute is used to set the top 
the HTML tag.

margin of a web page. It is given within the  tag with 
any value such as 60. This will display the text 60 
pixels away from the top of the page.

Syntax :  <BODY TOPMARGIN=60> 

LEFTMARGIN : This attribute is used to set the left 
margin of a web page. The value of left margin 
accordingly keeps the text away from the left corner 
of a page. 

Syntax :  <BODY  LEFTMARGIN = 50> 

IMG tag is an empty tag that is used to insert an Different types of list can be created in an HTML 
image in a web page. The value that it takes is the document. They are :
location of the file containing the image.

1. Unordered List
Syntax :  <IMG SRC = ‘‘Location of the image’’>

2. Ordered List
Any text placed between the comment tags will be 

7. HTML : Tags

A. 1. (b), 2. (a), 3. (c), 4. (a), 5. (d), 6. (c)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F), 6. (F)

C. 1. A web page is made up of different elements each 
of which is defined by HTML code or tag. An HTML 
tag always begins with a less than sign ‘<’ and ends 
with a greater than ‘>’ sign. For example, the tag 
that makes text bold is B. It is tagged as <B> within 
the text. This tag is written before the text you want 8. HTML : Lists and Tables
to bold. This is called opening tag or ON tag. In 

A. 1. (a), 2. (d), 3. (c), 4. (d), 5. (a)order to end the bold effect, you have to use a 
closing or an OFF tag. B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T), 6. (T)

2. C. 1.
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3. Definition List. <TITLE> Creating Nested List </TITLE>

Unordered List <UL> Tag </HEAD>

Unordered list or bulleted list is used when the <BODY>
items in the list are not required to be in a specific 

<CENTER> Versions of software </CENTER>
order. An unordered list is enclosed within the  

<UL Type = ‘SQUARE’><UL>..........</UL> tags. Each item in the list is 
given with the help of <LI> tag. The ‘TYPE’ attribute <LI>Microsoft OFFICE
of the <UL> tag allows you to specify the type of 

<OL TYPE = ‘1’>bullets you want for the list items. This attribute can 
take three values : Disc, Square and Circle to <LI>MS WORD
produce dark circle bullets, square bullets, and 

<LI>MS POWERPOINTwhite circle bullets before the list items, 
respectively. <LI>MS EXCEL

Ordered List <OL> Tag <LI>MS ACCESS

An ordered list is a list where the items are in a </OL>
specific order and need to be numbered. This kind 

</UL>of list could be used to give a list of items or to 
number the steps in a procedure. An ordered list is <UL>Type = ‘CIRCLE’>
enclosed within the  <OL>..........</OL> tags. Each 

<LI>  OPERATING SYSTEM
item in the list is given here also with the help of 

<OLType = ‘1’><LI> tag.

<LI>WINDOWS 95Syntax :  <OL  START = ‘Value’ TYPE = ‘1’ / ‘A’ / ‘a’ / ‘I’ / ‘i’>

Definition List Tag <LI>WINDOWS 98

<LI>WINDOWS XPA definition list tag is used to build a list of items, 
where each item has some block of text acting as a 

<LI>WINDOWS 7
definition.

</OL>
2. <TR> tag defines a horizontal row of cells while 

</UL><TD> tag specifies an individual block or cell in a 
table row. </BODY>

3. To create a hyperlink, <A> tag is used. The HREF </HTML>
attribute of the <A> tag stores the reference of the 

5. Do yourself.document that is to be linked. The text that appears 
on the hyperlink is enclosed between the starting 
tag <A>  and ending tag </A>.

Syntax : <A HREF = ‘‘Document Name’’> Hyperlink Text 
</A>

4. Cellpadding lets you define the distance between a 
cell boundary and its contents while cellspacing lets 
you add space between cells.

6. HTML allows you to nest a list within another list. 
The list that lies within another list is called a 
nested list. The browser automatically uses 
different bullets or numbering systems for the next 
level of indentation for the nested list. You can nest 
an ordered list within an unordered list and vice SCREEN 7
versa.

COLOR 15, 10
The following HTML coding shows you how the 

CLSnesting of lists works :

PRINT “A Triangle Using Line Statement’’<HTML>

LINE (160, 30) — (250, 180), 2<HEAD>

9. QBasic : Graphics and Sound

A. 1. (c), 2. (b), 3. (b), 4. (a), 5. (c)

B. 1. (F), 2. (F), 3. (T), 4. (T), 5. (T), 6. (F)

C. 1. Screen statement is used for selecting an 
appropriate screen mode for creating graphics in 
QBASIC. Its syntax is as follows :

Syntax : SCREEN [Screen mode number]

2. Line statement is used to draw a triangle in 
QBASIC.

Example : 
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LINE (250, 180) — (70, 180), 2 3. Searching for information on the internet or simply 
exploring the internet is commonly referred to as 

LINE (70, 180) — (160, 30), 2
surfing.

END
4. Three ways are :

3. BEEP and PLAY statements enables us to play 
• Finding information using search engine

music.
• Finding people on the internet

4. LINE statement is used to draw a straight line 
between two points on the screen while CIRCLE • Education through internet
statement is used to draw a circle, ellipse or arc of 

5. E–commerce refers to the buying and selling of 
a circle.

things over the internet. These days, a large 
5. To draw a circle in QBASIC, we use CIRCLE numbers of companies and business organizations 

statement. have set up their own websites providing details of 
their products and services and how to buy them. 

Syntax : CIRCLE (x, y), r, p
You can visit these sites and buy virtually anything 

Here, the co-ordinates x and y specify the centre on the internet.
location of a circle on the screen, ‘r’ gives the value 

6. Business-to-Business : This mode refers to a 
of the radius and ‘p’ specifies the colour code.

company selling or buying products or services 
6. Sixteen (16) colours can be used in background or from other companies.

foreground in QBASIC.
Consumer-to-Consumer : Consumer-to-
Consumer e commerce refers to auction sites where 
individual consumers put up items and other 
individual consumers bid for it. For example : ebay, 
yahoo auction, etc.

7. Digital Middlemen refers to a company which Internet, especially the world wide web part of it, is 
provides information about several companies on a a storehouse of huge amount of information on 
single website. These companies collects virtually any conceivable topic of public interest. 
information from other companies about the same Thus, Internet has made it easier to access and 
type of products (bikes, computer hardware, cars, share information, which can be in the form of text, 
etc), or services (travel and tourism, etc). A pictures, audio, or video. To extract information 
commission is charged for every sale or purchase from the internet is called information retrieval.
by the company hosting the website.

2. For video conferencing, we need a PC with internet 
connectivity, a digital camera properly configured 
and connected to PC and a video conferencing 
software such as Microsoft Net Meeting.

10. Internet Services and E–commerce

A. 1. (b), 2. (a), 3. (c), 4. (d), 5. (b)

B. 1. (F), 2. (T), 3. (T), 4. (T), 5. (T), 6. (F)

C. 1.




